Overview

This section provides basic information about the product and this Guide.

Related Topics

- About This Guide, on page 1
- Product Overview, on page 1
- About Cisco Prime Infrastructure Licensing, on page 1

About This Guide

This guide describes how to install Cisco Prime Infrastructure 3.5 as an OVA on VMware, Cisco Prime Infrastructure as an ISO on Hyper-V Virtual Machine. Prime Infrastructure is also available as a hardware appliance. For information on how to install the appliance, see the latest Cisco Prime Infrastructure Appliance Hardware Installation Guide. This guide also describes about the Upgrade & Migration from the supported previous release Cisco Prime Infrastructure versions to Cisco Prime Infrastructure 3.5.

For information about configuring and managing this product, see the Cisco Prime Infrastructure Administrator Guide and the Cisco Prime Infrastructure User Guide.

Product Overview

Prime Infrastructure provides a single integrated solution for comprehensive lifecycle management of the wired or wireless access, campus, and branch networks, and rich visibility into end-user connectivity and application performance assurance issues. Prime Infrastructure accelerates the rollout of new services, secure access and management of mobile devices, making “Bring Your Own Device” (BYOD) a reality for corporate IT. Tightly coupling client awareness with application performance visibility and network control, Prime Infrastructure helps ensure uncompromised end-user quality of experience. Deep integration with the Cisco Identity Services Engine (ISE) further extends this visibility across security and policy-related problems, presenting a complete view of client access issues with a clear path to solving them.

For:

- An overview of Prime Infrastructure features and benefits, see the latest Cisco Prime Infrastructure Data Sheets.
- Information about frequently used Prime Infrastructure features, see the latest Cisco Prime Infrastructure User Guide.
- Information about features intended for administrators, see the latest Cisco Prime Infrastructure Administrator Guide.

About Cisco Prime Infrastructure Licensing

Prime Infrastructure licenses control the features that you can use and the number of devices you can manage using those features. For more information about:
Before You Install

Complete the tasks in the following sections before installing Prime Infrastructure.

- Understand System Requirements, on page 2
- How to Scale Prime Infrastructure, on page 5

Understand System Requirements

Prime Infrastructure comes in two main forms:

- **Virtual**: The Prime Infrastructure virtual appliance is packaged as an Open Virtualization Archive (OVA) file, which must be installed on a user-supplied, qualified server running VMware ESXi. This form allows you to run on the server hardware of your choice. You can also install the virtual appliance in any of four configurations, each optimized for a different size of enterprise network. For hardware requirements and capacities for each of the virtual appliance’s size options, see Virtual Appliance Options, on page 2.

- **Hyper V**: Cisco Prime Infrastructure for Microsoft Hyper-V extends Cisco networking benefits to Microsoft Windows Server Hyper-V deployments. For deploying Cisco Prime Infrastructure on Hyper-V Virtual appliance, see the latest Cisco Prime Infrastructure Installation and Migration Guide for Microsoft Hyper-V Virtual Machine.

- **Physical**: The physical appliance is packaged as a rack-mountable server, with Prime Infrastructure pre-installed and configured for you. For physical appliance hardware specifications and capacities, see Physical Appliance Options, on page 3

Virtual Appliance Options

During installation, you can choose one of four deployment configuration options. The following table summarizes the minimum server requirements for each option.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Express</th>
<th>Express-Plus</th>
<th>Standard</th>
<th>Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td>VMware Version</td>
<td>ESXi 5.5 or 6.0 or 6.5</td>
<td>ESXi 5.5 or 6.0 or 6.5</td>
<td>ESXi 5.5 or 6.0 or 6.5</td>
<td>ESXi 5.5 or 6.0 or 6.5</td>
</tr>
<tr>
<td>Virtual CPUs¹</td>
<td>4</td>
<td>8</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>Memory (DRAM)</td>
<td>12 GB</td>
<td>16 GB</td>
<td>16 GB</td>
<td>24 GB</td>
</tr>
<tr>
<td>HDD Size</td>
<td>300 GB</td>
<td>600 GB</td>
<td>900 GB</td>
<td>1.2 TB</td>
</tr>
<tr>
<td>Throughput (Disk IOPS)</td>
<td>200 MB/s</td>
<td>200 MB/s</td>
<td>200 MB/s</td>
<td>320 MB/s</td>
</tr>
</tbody>
</table>

¹ You can configure any combination of sockets and cores, the product of which must equal the number of virtual CPUs required. For example, if 16 virtual CPUs are required, you can configure 4 sockets with 4 cores, or 2 sockets with 8 cores, etc.
You can install any of the Prime Infrastructure options as an Open Virtual Appliance (OVA), running under VMWare ESXi, on your own hardware. If you choose this implementation, the server that you supply must meet or exceed the requirements shown in the table for the option that you select.

### Physical Appliance Options

Prime Infrastructure is available on the Prime Infrastructure Physical Appliance and Digital Network Architecture Center (DNAC) Appliance. Prime Infrastructure 3.6 is not supported on the PRIME-NCS-APL-K9 (also known as “Gen 1”). Prime Infrastructure 3.6 is supported on PI-UCS-APL-K9 (also known as the Gen 2 appliance), PI-UCSM5-APL-K9 (also known as Gen 3 appliance) and DN1-HW-APL (also known as DNAC Appliance). You can upgrade a Prime Infrastructure Physical Appliance running Prime Infrastructure 3.4.x or 3.5.x to Prime Infrastructure 3.6. If the existing setup has 3.1.x, 3.2.x, or 3.3.x versions, you must first upgrade it to 3.4.x version so as to upgrade to Prime Infrastructure 3.6 version. The physical appliance specifications are as follows:

<table>
<thead>
<tr>
<th>Specification</th>
<th>Configuration</th>
<th>Gen-2 Appliance</th>
<th>Gen-3 Appliance</th>
<th>DNAC Appliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware Specifications</td>
<td>CPU (cores/threads)</td>
<td>10 C/20 T</td>
<td>20C/40T</td>
<td>44 C/88 T</td>
</tr>
<tr>
<td></td>
<td>Memory</td>
<td>64 GB</td>
<td>64 GB</td>
<td>256 GB</td>
</tr>
<tr>
<td></td>
<td>Disk Capacity</td>
<td>4x900 GB</td>
<td>4x1.2 TB</td>
<td>4X 1.8 TB</td>
</tr>
<tr>
<td></td>
<td>RAID Level RAID</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Disk I/O Speed</td>
<td>320 MBps</td>
<td>320 MBps</td>
<td>320 MBps</td>
</tr>
<tr>
<td>System Users</td>
<td>Concurrent GUI clients</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Concurrent API clients</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

**Note**

Gen-3 Appliance is supported from Prime Infrastructure 3.4.1.

While installing Prime Infrastructure on physical appliances, make sure management IP address should be configured to Gigabit Ethernet 0 interface.

Prime Infrastructure is also available pre-installed on Cisco-supplied hardware as a physical appliance. See the latest Cisco Prime Infrastructure Appliance Hardware Installation Guide for more information.

For maximum management capacities for each installation option, see How to Scale Prime Infrastructure, on page 5

### How to Improve the Performance of Appliances

For better performance on the Prime Infrastructure Appliance (Gen 2 & Gen 3) or DNAC Appliance, make sure you configure the virtual drive Write Policy to Write Back Good BBU. To configure the virtual drive Write Policy, follow these steps:
Procedure

Step 1 Launch the CIMC web interface (see the section *How to Set Up the Appliance* in the latest *Cisco Prime Infrastructure Appliance Hardware Installation Guide*).

Step 2 Click the *Storage* tab, click on the SAS Modular Controller name, click the *Virtual Drive* tab, then click *Edit Virtual Drive*.

Step 3 Click *OK* on the dialog box that appears.

Step 4 In the Write Policy field, select *Write Back Good BBU*, then click *Save Changes*.

If you are running ESX on custom hardware that has a RAID controller, we recommend you configure the following RAID settings to optimize Prime Infrastructure performance and redundancy:

- RAID 10
- RAID cache of at least 2 GB
- Use Write Back Good BBU

Web Client Requirements

Prime Infrastructure users access the product using a web browser client. Web client requirements are:

- Hardware—A Mac or Windows 7 or Windows 10 laptop or desktop compatible with one of the following tested and supported browsers:
  - Google Chrome 65 or later
  - Microsoft Internet Explorer 11 (No plug-ins are required.)
  - Mozilla Firefox ESR 59
  - Mozilla Firefox 59 or later

- Display resolution—Prime Infrastructure supports 1366 x 768 or higher, but we recommend that you set the screen resolution to 1600 x 900.

*Note*

Due to strict certificate check in Firefox browser, when you have two different Prime Infrastructure server with same hostname you will get the below error code:

- Failed : Error code: SEC_ERROR_REUSED_ISSUER_AND_SERIAL

To avoid this you can import CA Signed certificate in PI server through admin CLI. See *Import CA-Signed Host Certificates* from *Cisco Prime Infrastructure 3.5 Admin Guide* steps to generate CSR and import CA signed certificate.
How to Scale Prime Infrastructure

Prime Infrastructure comes with a variety of server installation options (see Understand System Requirements, on page 2). Ensure that you select an option appropriate for the size and complexity of your network.

The following table lists the maximum number of devices, clients, events, NetFlow-related data flows, and other scale parameters for each option. For example, the Professional option can manage 200,000 wireless clients and 50,000 wired clients.

*Table 2: Supported Scale for Prime Infrastructure Installation Options (includes Assurance)*

<table>
<thead>
<tr>
<th>Parameter (Maximums)</th>
<th>Express</th>
<th>Express-Plus</th>
<th>Standard</th>
<th>Professional</th>
<th>Hardware Appliance (Gen 2)</th>
<th>Hardware Appliance (Gen 3)</th>
<th>DNAC Appliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of devices (combination of wired and wireless devices)</td>
<td>500</td>
<td>3000</td>
<td>10,000</td>
<td>14,000</td>
<td>24,000</td>
<td>24,000</td>
<td>24,000</td>
</tr>
<tr>
<td>Unified APs</td>
<td>300</td>
<td>2500</td>
<td>5000</td>
<td>10,000</td>
<td>20,000</td>
<td>20,000</td>
<td>20,000</td>
</tr>
<tr>
<td>Autonomous APs</td>
<td>300</td>
<td>500</td>
<td>1500</td>
<td>2500</td>
<td>3,000</td>
<td>3,000</td>
<td>3,000</td>
</tr>
<tr>
<td>Wired Devices</td>
<td>300</td>
<td>1000</td>
<td>6000</td>
<td>10,000</td>
<td>13,000</td>
<td>13,000</td>
<td>13,000</td>
</tr>
<tr>
<td>NAMs</td>
<td>5</td>
<td>5</td>
<td>500</td>
<td>800</td>
<td>1000</td>
<td>1000</td>
<td>1000</td>
</tr>
<tr>
<td>Controllers</td>
<td>5</td>
<td>25</td>
<td>500</td>
<td>800</td>
<td>1,000</td>
<td>1000</td>
<td>1000</td>
</tr>
<tr>
<td>Wired Clients</td>
<td>6000</td>
<td>50,000</td>
<td>50,000</td>
<td>50,000</td>
<td>50,000</td>
<td>50,000</td>
<td>50,000</td>
</tr>
<tr>
<td>Wireless Clients</td>
<td>4000</td>
<td>30,000</td>
<td>75,000</td>
<td>150,000</td>
<td>200,000</td>
<td>200,000</td>
<td>200,000</td>
</tr>
<tr>
<td>Cisco Mobility Services Engine (MSE)</td>
<td>1</td>
<td>1</td>
<td>6</td>
<td>10</td>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>Changing Clients (every 5 minutes)$^4$</td>
<td>1000</td>
<td>5000</td>
<td>25,000</td>
<td>30,000</td>
<td>40,000</td>
<td>40,000</td>
<td>40,000</td>
</tr>
<tr>
<td>Events Sustained Rate (events per second; includes syslogs, traps, and system events)</td>
<td>100</td>
<td>100</td>
<td>300</td>
<td>500</td>
<td>1000</td>
<td>1000</td>
<td>1000</td>
</tr>
<tr>
<td>Syslog Rate</td>
<td>70</td>
<td>70</td>
<td>210</td>
<td>350</td>
<td>600</td>
<td>600</td>
<td>600</td>
</tr>
<tr>
<td>Trap Rate</td>
<td>20</td>
<td>20</td>
<td>60</td>
<td>100</td>
<td>300</td>
<td>300</td>
<td>300</td>
</tr>
<tr>
<td>System Event Rate</td>
<td>10</td>
<td>10</td>
<td>30</td>
<td>50</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>NetFlow Rate (flows per second)$^4$</td>
<td>3000</td>
<td>3000</td>
<td>16,000</td>
<td>40,000</td>
<td>80,000</td>
<td>80,000</td>
<td>80,000</td>
</tr>
</tbody>
</table>
### Parameter (Maximums)

<table>
<thead>
<tr>
<th>Parameter (Maximums)</th>
<th>Express</th>
<th>Express-Plus</th>
<th>Standard</th>
<th>Professional</th>
<th>Hardware Appliance (Gen 2)</th>
<th>Hardware Appliance (Gen 3)</th>
<th>DNAC Appliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Hourly Host Records</td>
<td>144,000</td>
<td>720,000</td>
<td>2,100,000</td>
<td>6,000,000</td>
<td>12,000,000</td>
<td>12,000,000</td>
<td>12,000,000</td>
</tr>
<tr>
<td>Interfaces</td>
<td>12,000</td>
<td>50,000</td>
<td>250,000</td>
<td>250,000</td>
<td>350,000</td>
<td>350,000</td>
<td>350,000</td>
</tr>
<tr>
<td>Compliance Violation Limit&lt;sup&gt;2&lt;/sup&gt;</td>
<td>—</td>
<td>—</td>
<td>20000</td>
<td>80000</td>
<td>80000</td>
<td>80000</td>
<td>80000</td>
</tr>
<tr>
<td>NAM Data Polling Enabled</td>
<td>5</td>
<td>5</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Polling Interfaces (polling of trunk ports)</td>
<td>2400</td>
<td>8000</td>
<td>48,000</td>
<td>100,000</td>
<td>100,000</td>
<td>100,000</td>
<td>100,000</td>
</tr>
<tr>
<td>Number of Sites/Campus</td>
<td>200</td>
<td>500</td>
<td>2500</td>
<td>2500</td>
<td>2500</td>
<td>2500</td>
<td>2500</td>
</tr>
<tr>
<td>Groups: User-Defined + Out of the Box + Device Groups + Port Groups</td>
<td>50</td>
<td>100</td>
<td>150</td>
<td>150</td>
<td>150</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>Location Group</td>
<td>100</td>
<td>100</td>
<td>1000</td>
<td>1000</td>
<td>1000</td>
<td>1000</td>
<td>1000</td>
</tr>
<tr>
<td>Virtual Domains</td>
<td>100</td>
<td>500</td>
<td>750</td>
<td>750</td>
<td>750</td>
<td>750</td>
<td>750</td>
</tr>
<tr>
<td>Concurrent GUI Clients</td>
<td>5</td>
<td>10</td>
<td>25</td>
<td>50</td>
<td>50</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>Concurrent API (or northbound interface) Clients</td>
<td>2</td>
<td>2</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

<sup>2</sup> Compliance is supported on the Standard, Professional virtual appliance (OVA) and the Gen 2 appliance, Gen 3 appliance and DNAC Appliance only. It is not supported on: Express, Express Plus, OVAs that have been resized to Standard or Professional. If you are running Prime Infrastructure on an unsupported OVA or physical appliance and want to enable Compliance, you must perform a fresh install of the 3.5 Standard or Professional OVA or Gen2 appliance or Gen 3 Appliance or DNAC Appliance, then use backup/restore to migrate data from your old server to the new server. See Enabling Compliance Services in the Cisco Prime Infrastructure 3.5 Administrator Guide.

<sup>3</sup> Changing Clients are wireless users who are roaming across APs or disassociating and associating to APs.

<sup>4</sup> The NetFlow rate depends on the number of unique clients in the flows. The supported NetFlow rate is also based on the translated number of hourly host records (or unique combinations of server/client and applications) per day.

<sup>5</sup> If the Compliance violation for the Professional virtual appliance exceeds 80000, the compliance job will not show any data.
Supported Scale for PnP Provisioning:

- Maximum number of devices per profile: 100
- Maximum number of Simultaneous Deployments per APIC-EM limitation: 50 (Threads)

We recommend that you maintain an acceptable level of latency between your devices and the Cisco Prime Infrastructure server. A high latency might result in the server being unable to manage your devices, or the background tasks running slowly. A typical example of such a scenario is when you have thousands of APs and multiple Cisco Wireless Controllers managed by Prime Infrastructure across a WAN. In such a situation, we recommend that you install Prime Infrastructure in a local setup to ensure that the device response time is not impacted by queries from Prime Infrastructure.

How to Scale for Service Provider Wi-Fi

The following table lists the Service Provider Wi-Fi parameters.

Table 3: Scaling for Service Provider Wi-Fi

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Maximum Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of APs</td>
<td>20,000</td>
</tr>
<tr>
<td>Number of clients</td>
<td>100,000</td>
</tr>
<tr>
<td>Sustain trap rate</td>
<td>300/sec</td>
</tr>
<tr>
<td>Burst trap rate</td>
<td>400/sec for 10-minute duration</td>
</tr>
</tbody>
</table>

How to Scale for Operations Center

When using Operations Center, we recommend that you:

- Use the Standard OVA installation option.
- Ensure that your network is providing the following performance levels between Operations Center and its managed devices:
  - Bandwidth—250 Kbps
  - Latency—up to 5 ms. This is not a hard requirement, but Operations Center will only be as fast as its slowest managed instance. The higher the latency, the slower the overall performance. Use the Network Latency column on the Operations Center Manage & Monitor Servers page to spot managed instances that may be acting as bottlenecks.
- Ensure all instances managed by Operations Center are running Prime Infrastructure 3.5.

To help you roll out new versions of Prime Infrastructure at your own pace, Operations Center always supports management of instances of both the current and the very last version of Prime Infrastructure (also known as “N-1 management”). For example: If you upgrade your Operations Center management server to 3.5, you can use that server to continue managing Prime Infrastructure 3.4.x instances, as well as upgraded 3.5 Prime Infrastructure instances.
Make sure that you do the following when you are upgrading the Operation Center:

- Remove the managed instances before upgrading the Operation Center.
- Upgrade the Operation Center.
- Re-add the managed instances.

The following table lists the Operations Center scaling parameters.

### Table 4: Scaling Operations Center

<table>
<thead>
<tr>
<th>Operations Center Parameter</th>
<th>Maximum Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of managed instances</td>
<td>10</td>
</tr>
<tr>
<td>Number of managed virtual domains</td>
<td>100</td>
</tr>
<tr>
<td>Concurrent GUI clients</td>
<td>100</td>
</tr>
</tbody>
</table>

See Physical Appliance Options, on page 3 for physical appliance options and the table under the section How to Scale Prime Infrastructure, on page 5 for installation option scaling information. For more information, see Set Up Operations Center in the latest Cisco Prime Infrastructure Administrator Guide.

### How to Scale for Data Center

The following table lists the Data Center parameters.

### Table 5: Scaling Data Center

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Devices</th>
<th>Standard</th>
<th>Professional</th>
<th>Hardware Appliance (Gen 2)</th>
<th>Hardware Appliance (Gen 3)</th>
<th>DNAC Appliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Center Switches</td>
<td>Cisco Nexus devices</td>
<td>2500</td>
<td>3000</td>
<td>3000</td>
<td>3000</td>
<td>3000</td>
</tr>
<tr>
<td></td>
<td>VMware vCenters</td>
<td>7</td>
<td>14</td>
<td>14</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>VMware Hosts</td>
<td>472</td>
<td>1219</td>
<td>1219</td>
<td>1219</td>
<td>1219</td>
</tr>
<tr>
<td></td>
<td>VMware Clusters</td>
<td>8</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Virtual machines</td>
<td>5500</td>
<td>12000</td>
<td>12,000</td>
<td>12,000</td>
<td>12,000</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>10587</td>
<td>18648</td>
<td>18,648</td>
<td>18,648</td>
<td>18,648</td>
</tr>
</tbody>
</table>
How to Scale for CDB

The following table lists the number of records with the approximate size on disks for CDB parameters.

**Table 6: Supported Scale for CDB**

<table>
<thead>
<tr>
<th>CDB/Install Type</th>
<th>Express</th>
<th>Express-Plus</th>
<th>Standard</th>
<th>Professional</th>
<th>Hardware Appliance (Gen 2)</th>
<th>Hardware Appliance (Gen 3)</th>
<th>DNA Appliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CoreConv</td>
<td>123120000</td>
<td>123120000</td>
<td>123120000</td>
<td>123120000</td>
<td>615600000</td>
<td>615600000</td>
<td>615600000</td>
</tr>
<tr>
<td></td>
<td>950 MB</td>
<td>950 MB</td>
<td>950 MB</td>
<td>950 MB</td>
<td>45 GB</td>
<td>45 GB</td>
<td>45 GB</td>
</tr>
<tr>
<td>ARTCltSvr</td>
<td>100440064</td>
<td>100440064</td>
<td>100440064</td>
<td>100440064</td>
<td>502200000</td>
<td>502200000</td>
<td>502200000</td>
</tr>
<tr>
<td></td>
<td>750 MB</td>
<td>750 MB</td>
<td>750 MB</td>
<td>750 MB</td>
<td>40GB</td>
<td>40GB</td>
<td>40GB</td>
</tr>
<tr>
<td>Custom</td>
<td>100440064</td>
<td>100440064</td>
<td>100440064</td>
<td>100440064</td>
<td>5808098304</td>
<td>5808098304</td>
<td>5808098304</td>
</tr>
<tr>
<td>NetFlow (per CDB created by user)</td>
<td>500 MB * no. of custom cdbs created</td>
<td>500 MB * no. of custom cdbs created</td>
<td>500 MB * no. of custom cdbs created</td>
<td>500 MB * no. of custom cdbs created</td>
<td>5 GB * no. of custom cdbs created</td>
<td>5 GB * no. of custom cdbs created</td>
<td>5 GB * no. of custom cdbs created</td>
</tr>
<tr>
<td>Disk Space used by Other CDBs</td>
<td>3 GB approximately</td>
<td>3 GB approximately</td>
<td>3 GB approximately</td>
<td>6 GB approximately</td>
<td>10GB approximately</td>
<td>10GB approximately</td>
<td>10GB approximately</td>
</tr>
</tbody>
</table>

**Installation Options**

Prime Infrastructure provides the following installation options:

- New installation on a virtual machine—See **Before You Begin Installation on a Virtual Machine, on page 9**.
- New installation on a physical appliance. Prime Infrastructure comes preinstalled on physical appliances, or you can install an image on an existing appliance. See **Set Up Prime Infrastructure on a Virtual Machine or Physical Appliance, on page 11**.
- Upgrade a previous version of Prime Infrastructure—See **How to Upgrade From Previous Releases of Prime Infrastructure, on page 12**.

**Before You Begin Installation on a Virtual Machine**

Before installing Prime Infrastructure on a virtual machine, you must:

- Ensure that VMware ESXi is installed and configured on the machine that you plan to use as the Prime Infrastructure server. See **VMware documentation** for information on setting up and configuring a VMware host. If you are using VMware ESX 5.5, you must use vSphere Client or ESX5.5U2 (or later) Client to manage the virtual machine. Do not edit the virtual machine settings and do not extend or manually add additional disks to the configuration.
- Check that the installed VMware ESXi host is reachable. See the VMware documentation on how to install the VMware vSphere Client. After the virtual host is available on the network, you can browse to its IP address to display a web-based interface from which you can install the VMware vSphere Client.
• Ensure that the Prime Infrastructure OVA is saved to the same machine where your VMware vSphere Client is installed. Depending on your arrangement with Cisco, you may download the OVA file PI-VA-3.5.0.0.550.ova from Cisco.com or use your Cisco-supplied installation media. Verify the integrity of the OVA file using its checksum listed on Cisco.com.

Install Prime Infrastructure on a Virtual Machine

The following steps explain how to install Prime Infrastructure on a virtual machine. Make sure that all of the system requirements are met before you deploy the OVA. Review the sections Understand System Requirements and Before You Begin Installation on a Virtual Machine, on page 9.

Note
If you are upgrading from a Prime Infrastructure 3.4.x or 3.5.x virtual machine, you should create a new virtual machine with the same deployment configuration option you used previously (for example, Express, Express-Plus, Standard, or Professional), back up your existing virtual machine, and then restore it on the new virtual machine.

If you are using Esxi 6.5 or later, you can deploy latest ova using Web Client.

Procedure

Step 1
Launch your VMware vSphere Client and connect to the ESXi host or vCenter server.

Step 2
Choose File > Deploy OVF Template.

Step 3
Click Browse to access the location where you have saved the OVA file on your local machine, then click Next.

Step 4
Verify the details on the OVF template details page, then click Next.

Note We will reserve the entire CPU resources and half of the memory based on your OVA selection.

Note Ensure the Publisher field shows Cisco Systems, Inc.

Step 5
In the End User License Agreement window, click Accept, then click Next.

Step 6
In the Name and Location window, specify:

• In the Name field, enter the name of the new virtual machine.

• In the Inventory Location area, select the appropriate folder. (If the vSphere Client is connected directly to an ESXi host, this option does not appear.)

Step 7
Click Next.

Step 8
In the Deployment Configuration window, select the desired configuration (for example, Express, Express Plus, Standard, Professional, etc.) and view the resources required for the configuration you selected.

Note We recommend you reserve 100% of CPU and memory resources for optimal performance.

Step 9
Click Next.

Step 10
In the Host/Cluster window, select the host or cluster on which you want to deploy the OVF template, then click Next. (If the vSphere Client is connected directly to an ESXi host, this option does not appear.)
Step 11 In the Storage window, select the datastore that has the required space requirements described in Understand System Requirements, on page 2, then click Next.

Step 12 In the Disk Format window, select Thick Provisioning to provision the virtual machine virtual disks, then click Next. Do not select Thin Provision because if there is no free disk space when the virtual machine needs it, Prime Infrastructure will fail.

Step 13 In the Network Mapping window, select a network for the virtual machine to use, then click Next.

Step 14 In the Ready to Complete window, review your settings, select Power on After Deployment, then click Finish.

Depending on your network speed and the IOPS of the server, the deployment can take a few minutes to complete.

---

Set Up Prime Infrastructure on a Virtual Machine or Physical Appliance

Prime Infrastructure comes preinstalled on physical appliances, or you can install an image on an existing appliance. Complete the following steps to set up and start Prime Infrastructure on a virtual machine or physical appliance.

**Procedure**

**Step 1** If you are using a virtual machine and it is not already powered on, in the VMware vSphere Client, right-click the deployed virtual appliance and choose Power > Power On.

**Step 2** Click the Console tab.

After the server boots up, you’ll see the localhost login prompt.

**Step 3** At the localhost login prompt, enter setup.

**Step 4** The console prompts you for the following parameters:

- Hostname—The host name of the virtual appliance.
- IP Address—The IP address of the virtual appliance.
- IP default netmask—The default subnet mask for the IP address.
- IP default gateway—The IP address of the default gateway.

**Note** If an IPv6 address is not manually configured on the interface, or discovered dynamically, the IPv6 address will be automatically configured.

- Default DNS domain—The default domain name.
- Primary nameserver—The IP address of the primary name server.
- Secondary name servers—The IP address if the secondary name server, if available. You can add up to three secondary name servers.
- Primary NTP server—The IP address or host name of the primary Network Time Protocol server you want to use. (time.nist.gov is the default).
- Secondary NTP servers—The IP addresses or host names of the secondary NTP servers to be used when the primary is not available.

- System Time Zone—The time zone code you want to use. See the chapter Time Zones Supported By Cisco Prime Infrastructure in the Cisco Prime Infrastructure User Guide.

- Clock time—The clock time based on the server’s time zone.

- Username—The name of the first administrative user (known as “admin”). This is the administrator account used to log in to the server via the console or SSH. You can accept the default, which is admin.

- Password—Enter the admin user password and then confirm it.

Tip Keep your Prime Infrastructure password in a safe place. If you forget the password, see the section How to Recover Administrator Passwords on Virtual Appliances in the latest Cisco Prime Infrastructure Administrator Guide.

Step 5 When you are done entering these values, you will be prompted for the following parameters:

- **High Availability Role Selection**—Enter yes at the prompt if you want this installed server to serve as the secondary server in a high availability implementation. You will be prompted to provide an authentication key to be used for high availability registration. If you enter no at the prompt, the server will act as the primary server (standalone) and the installation will proceed with the following prompts:

- **Advance Security option**—You will be prompted for accessing root shell. Enter Yes at the prompt to enable root shell access. Enter No to disable root shell access.

- **Web Interface Root Password**—Enter and confirm the password used for the default root administrator. This is the account used to log in to the Prime Infrastructure web user interface for the first time and set up other user accounts.

Step 6 Select Yes to proceed with the installation, or select No to re-enter high availability options.

Step 7 When you are done entering these values, the installer application tests the network configuration parameters you have entered. If the tests are successful, it begins installing Prime Infrastructure.

Step 8 When the installation is complete, the appliance reboots and you are presented with a login prompt.

Step 9 Log in to the virtual machine using the “admin” username and password that you specified in Step 4.

Step 10 Run the ncs status command (see the section Check Prime Infrastructure Server Status in the latest Cisco Prime Infrastructure User Guide) to verify that the processes have restarted. You should see the following process statuses:

- All Processes are up and running.

---

**How to Upgrade From Previous Releases of Prime Infrastructure**

You can upgrade the following 3.1.x, 3.2.x, 3.3.x and 3.4.x Prime Infrastructure versions to Prime Infrastructure 3.5:

- Cisco Prime Infrastructure 3.4.1
- Cisco Prime Infrastructure 3.4
- Cisco Prime Infrastructure 3.3.1
If your product/version is not in this list, to upgrade to 3.5, you must first upgrade to version 3.1.x, 3.2.x, 3.3.x and 3.4.x at a minimum.

If you are running multiple versions of Prime Infrastructure from which you want to migrate data, see Migrate Data From Previous Releases of Prime Infrastructure, on page 15.

Remember that backups can only be restored to a new Prime Infrastructure server that is the same size or bigger than your previous server. See How to Scale Prime Infrastructure, on page 5.

Before you upgrade from Operations Center 3.1.x, 3.2.x, 3.3.x, 3.4.x to 3.5, make sure you upgrade any Prime Infrastructure instances that are managed in Operations Center from Prime Infrastructure 3.1.x, 3.2.x, 3.3.x, 3.4.x to Prime Infrastructure 3.5.

To back up your data from a previous supported version of Prime Infrastructure, follow these steps:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>If you have not already done so: Set up a remote backup repository for the Prime Infrastructure version you are currently running. For details, see the section Using Remote Backup Repositories in the latest Cisco Prime Infrastructure Administrator Guide.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Take an application backup of the Prime Infrastructure version you are currently running, and store the backup in the remote repository. For details, see the section Perform an Immediate Application Backup Using the CLI in the latest Cisco Prime Infrastructure Administrator Guide.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Verify the integrity of the backup as explained in Before You Migrate Your Data, on page 15.</td>
</tr>
</tbody>
</table>

**What to do next**

You can upgrade Prime Infrastructure using either of the following methods:

- Perform an inline upgrade of existing 3.1.x, 3.2.x, 3.3.x or 3.4.x system—See How to Perform an Inline Upgrade, on page 13.
- Restore data from backup on running system—See Before You Migrate Your Data, on page 15.

**How to Perform an Inline Upgrade**

Inline upgrade is simpler than system migration, and requires no new hardware. Prime Infrastructure 3.5 supports inline upgrade from Prime Infrastructure 3.1.x/3.2.x/3.3.x/3.4.x.
It does not support upgrading the existing secondary server, you can install fresh secondary server using secondary Prime Infrastructure 3.5 OVA image and integrate it with the primary server for high availability. For details, see Install Prime Infrastructure on a Virtual Machine, on page 10.

The following steps explain how to upgrade from primary Prime Infrastructure 3.1.x or 3.2.x or 3.3.x or 3.4.x to Prime Infrastructure 3.5.

**Procedure**

**Step 1** Set up a remote backup repository for the Prime Infrastructure version you are currently running. For details, see the section **Use a Remote Backup Repository** in the latest Cisco Prime Infrastructure Administrator Guide.

**Step 2** Take an application backup of the Prime Infrastructure version you are currently running, and store the backup in the remote repository. For details, see the section **Perform an Immediate Application Backup Using the CLI** in the latest Cisco Prime Infrastructure Administrator Guide.

**Step 3** Verify the integrity of the backup as explained in Before You Migrate Your Data.

**Step 4** Remove any existing High Availability configuration from your primary Prime Infrastructure server. You can do this using either of the following options:

- Launch Prime Infrastructure, choose **Administration > Settings > High Availability > HA Configuration**, and click **Remove**. Ensure the configuration mode changes to “HA Not Configured.”
- Ensure the primary server is the active Prime Infrastructure server, go to the admin console on the primary server and run the **ncs ha remove** command.

**Step 5** Move backup files (all files with the tar.gz extension) from the /localdisk directory to another server and ensure that /localdisk has 80% free space. For details, see the sections **copy and delete commands** and **show disks command** in the latest Command Reference Guide for Cisco Prime Infrastructure.

**Step 6** Download the upgrade bundle PI-Upgrade-3.X_to_3.5.0.0.550.tar.gz from Cisco.com and verify the integrity using its checksum listed on Cisco.com.

**Step 7** Copy the verified upgrade file to the default repository:

**Example:**

```
admin# copy source
disk
:/:defaultRepo
```

Where:

- **source** is the upgrade file’s URL, path and filename (for example: FTP://<YourFTPServer>/(PI-Upgrade-3.X_to_3.5.0.0.550.tar.gz).
- **disk** is the disk and path to the local defaultRepo.

**Step 8** Ensure the current version of Prime Infrastructure is 3.1.x or 3.2.x or 3.3.x or 3.4.x.

**Step 9** Ensure the local repository (defaultRepo) contains no backup files.

**Step 10** Stop the Prime Infrastructure server by entering the command **ncs stop**

**Step 11** It is recommended to run the application upgrade from the console. For a virtual appliance, you can run the application upgrade from the VM console. For a physical appliance, you can run the application upgrade from the KVM, VGA, or serial console. (If you are using the serial console, make sure baud rate is configured to 9600.)
**Example:**

```
admin# application upgrade PI-Upgrade-3.X_to_3.5.0.0.550.tar.gz defaultRepo (For upgrading from 3.1.x/3.2.x/3.3.x/3.4.x to 3.5)
```

This step can take several hours to complete, depending on the size of the application database.

**Step 12**

When the upgrade is complete:

- Verify that the application is running by entering the `ncs status` command in the admin console.
- Instruct users to clear the browser cache on all client machines that accessed an older version of Prime Infrastructure before they try to connect to the upgraded Prime Infrastructure server.
- If you were using external AAA (RADIUS or TACACS) before the upgrade, see the section *Renew AAA Settings After Installing a New Prime Infrastructure Version* in the latest *Cisco Prime Infrastructure Administrator Guide*.
- If you are using Prime Infrastructure to manage Cisco Wireless LAN Controllers, see *Resynchronize WLC Configurations after Migration*.
- Synchronize your devices as explained in the section *Synchronize Devices* in the latest *Cisco Prime Infrastructure User Guide*.

---

**Before You Migrate Your Data**

You should check the validity of your Prime Infrastructure backup data by setting up an additional Prime Infrastructure server (either a spare Prime Infrastructure appliance or a new Prime Infrastructure virtual machine) and perform the restore operation as explained in *Restore an Application Backup* in the *Cisco Prime Infrastructure Administrator Guide*. If you do not have an additional Prime Infrastructure system to validate the backup, take at least two backups to reduce the risk of losing data.

If the restore operation does not work, or there are problems with the backed up image, try taking another backup from a production system, or try restoring from an earlier Prime Infrastructure backup.

If you cannot create a verified backup before installing this version of Prime Infrastructure, open a support case with Cisco TAC.

**Migrate Data From Previous Releases of Prime Infrastructure**

You can migrate from the following 3.1.x or 3.2.x or 3.3.x or 3.4.x Prime Infrastructure versions to Prime Infrastructure 3.5:

- Cisco Prime Infrastructure 3.4.1
- Cisco Prime Infrastructure 3.4
- Cisco Prime Infrastructure 3.3.1
- Cisco Prime Infrastructure 3.3
- Cisco Prime Infrastructure 3.2.2
- Cisco Prime Infrastructure 3.2.1
- Cisco Prime Infrastructure 3.2
- Cisco Prime Infrastructure 3.1.7
- Cisco Prime Infrastructure 3.1.6
If you are running multiple previous releases of Prime Infrastructure (for example, you are running version 3.1.4 or 3.2.2 or 3.3.1 or 3.4.1), you must select one version from which to restore data. You cannot restore data from more than one Prime Infrastructure version. To combine data from multiple Prime Infrastructure versions:

1. Perform the restore operation for one Prime Infrastructure system running a previous Prime Infrastructure version.
2. Export your device inventory and maps from other Prime Infrastructure systems and import the information into the Prime Infrastructure 3.5 system.

See Before You Migrate Your Data before you start the following steps to restore your data from Prime Infrastructure 3.1.x or 3.2.x or 3.3.x or 3.4.x to your newly installed Prime Infrastructure 3.5 server:

Procedure

**Step 1** Configure the new Prime Infrastructure host to use the same remote backup repository as the old host. For details, see Use a Remote Backup Repository in the Cisco Prime Infrastructure Administrator Guide.

**Step 2** Restore the application backup on the remote repository to the new host, as explained in Restore an Application Backup in the Cisco Prime Infrastructure Administrator Guide.

**Step 3** When the process is complete:

- Instruct users to clear the browser cache on all client machines that accessed an older version of Prime Infrastructure before they try to connect to the upgraded/restored Prime Infrastructure server.
- If you are using Prime Infrastructure to manage Cisco Wireless LAN Controllers, see Resynchronize WLC Configurations after Migration, on page 17.
- Synchronize your devices as explained in Synchronize Devices in the Cisco Prime Infrastructure User Guide.

**Step 4** After the new Prime Infrastructure 3.5 server is operational, decommission your previous server.

---

**Assurance Data after Migration**

After restoring Prime Infrastructure 3.1.x/3.2.x/3.3.x/3.4.x on a new Prime Infrastructure 3.5 virtual machine or hardware appliance, your Assurance license is automatically applied to the new server.

When you move your data to Prime Infrastructure 3.5, the following Assurance data is not migrated:

- Raw NetFlow information
- Custom NetFlow reports
- Packet capture files
- Processed non-aggregated data, such as PFR data and URLs
Resynchronize WLC Configurations after Migration

After you restore the backup of the previous version on the 3.1.x/3.2.x/3.3.x/3.4.x version of Prime Infrastructure, your server’s records of Cisco Wireless LAN Controller configurations might be out of sync with the configurations stored on those devices. Resynchronize them using the following steps before continuing.

**Procedure**

**Step 1** Log in to Prime Infrastructure.

**Step 2** Choose **Inventory > Network Devices > Wireless Controller**. Prime Infrastructure displays a list of all the controllers it is managing, including all Cisco WLCs.

**Step 3** Select a device, then click **Sync**.

**Step 4** Repeat steps 2 and 3 for all your other WLCs.

Post-Installation Tasks

Follow the instructions in this section once you have finished installing Prime Infrastructure.

**Log in to the Prime Infrastructure User Interface**, on page 17

**Get Started Using Prime Infrastructure**, on page 18

**Log in to the Prime Infrastructure User Interface**

We strongly recommend you use signed certificates to ensure secure connections between clients and the Prime Infrastructure server. For information about creating a signed certificate, see **Import CA-Signed Certificates** in the latest Cisco Prime Infrastructure Administrator Guide.

Follow these steps to log in to the Prime Infrastructure user interface through a web browser:

**Procedure**

**Step 1** Launch one of the Supported Browsers (see **Understand System Requirements**, on page 2) on a different computer from the one on which you installed and started Prime Infrastructure.

**Step 2** In the browser’s address line, enter https://ipaddress, where *ipaddress* is the IP address of the server on which you installed Prime Infrastructure. The Prime Infrastructure user interface displays the **Login** window.

When you access Prime Infrastructure for the first time, some browsers will display a warning that the site is untrusted. When this happens, follow the prompts to add a security exception and download the self-signed certificate from the Prime Infrastructure server. After you complete this procedure, the browser will accept the Prime Infrastructure server as a trusted site in all future login attempts.

**Step 3** Enter the *root* administrator username and password, as specified in **Set Up Prime Infrastructure on a Virtual Machine or Physical Appliance**, on page 11
Step 4  Click Login to log in to Prime Infrastructure. The user interface is now active and available for use. The home page appears.

If any licensing problems occur, a message appears in an alert box. If you have an evaluation license, the number of days until the license expires is shown. You are also alerted to any expired licenses. You have the option to go directly to the Administration > Licenses page to address these problems.

Step 5  To ensure system security, choose Administration > Users, Roles & AAA > Change Password to change the password for the root administrator.

To exit the user interface, close the browser page or click Logout in the top-right corner of the page. Exiting a Prime Infrastructure user interface session does not shut down Prime Infrastructure on the server.

If a system administrator stops the Prime Infrastructure server during your Prime Infrastructure user interface session, your session ends, and the browser displays this message: “The page cannot be displayed.” Your session does not re-associate to Prime Infrastructure when the server restarts. You must start a new Prime Infrastructure session.

Get Started Using Prime Infrastructure

After you install Prime Infrastructure, you must perform additional tasks to begin managing your network. If you are an administrator, see the following sections in the latest Cisco Prime Infrastructure Administrator Guide:

• Configure Data Sources for Cisco Prime Infrastructure With Assurance, including enable NetFlow and Performance Agent.
• How to Manage Disk Space Issues on Prime Infrastructure servers.
• Renew AAA Settings After Installing a New Prime Infrastructure Version
• Prime Infrastructure Software Updates

For information about installing the Cisco Plug and Play Application, see the Cisco Plug and Play Application Solutions Guide.

Users should complete the tasks listed in the chapter Get Started with Prime Infrastructure chapter in the latest Cisco Prime Infrastructure User Guide. After you complete these tasks, you are ready to start monitoring and configuring your network.

Reference Information

The following sections provide reference information about Prime Infrastructure and its support options.

• Ports Used by Prime Infrastructure and Assurance, on page 19
• Remove the Prime Infrastructure Virtual Appliance, on page 21
• Navigation and Documentation Reference, on page 21
• Related Documentation, on page 22
• Obtaining Documentation and Submitting a Service Request, on page 22
### Ports Used by Prime Infrastructure and Assurance

The below table lists the ports used by Prime Infrastructure and Assurance. These ports must be open in firewalls if you are using these services.

**Table 7: Ports Used by Prime Infrastructure and Assurance**

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol</th>
<th>Direction</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>TCP/UDP</td>
<td>Server to endpoints</td>
<td>Endpoint discovery via ICMP</td>
</tr>
<tr>
<td>20, 21</td>
<td>TCP</td>
<td>Bidirectional server/devices</td>
<td>FTP transfer of files to and from devices</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server to Cisco.com</td>
<td>FTP download of files from Cisco.com</td>
</tr>
<tr>
<td>22</td>
<td>TCP</td>
<td>Server to endpoints</td>
<td>To initiate SSH connection to endpoints during troubleshooting processes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Client to server</td>
<td>To connect to the Prime Infrastructure server</td>
</tr>
<tr>
<td>23</td>
<td>TCP</td>
<td>Server to devices</td>
<td>Telnet communication with devices</td>
</tr>
<tr>
<td>25</td>
<td>TCP</td>
<td>Server to SMTP server</td>
<td>SMTP email routing</td>
</tr>
<tr>
<td>49</td>
<td>TCP/UDP</td>
<td>Server to TACACS server</td>
<td>Authenticate users using TACACS</td>
</tr>
<tr>
<td>53</td>
<td>TCP/UDP</td>
<td>Server to DNS server</td>
<td>DNS</td>
</tr>
<tr>
<td>69</td>
<td>UDP</td>
<td>Devices to server</td>
<td>TFTP</td>
</tr>
<tr>
<td>80</td>
<td>HTTP</td>
<td>Server to devices</td>
<td>Provisioning of Nexus devices</td>
</tr>
<tr>
<td>161</td>
<td>UDP</td>
<td>Server to devices</td>
<td>SNMP polling</td>
</tr>
<tr>
<td>162</td>
<td>TCP/UDP</td>
<td>Endpoints to server</td>
<td>SNMP Trap receiver port</td>
</tr>
<tr>
<td>443</td>
<td>TCP</td>
<td>Client to server</td>
<td>Browser access to Prime Infrastructure via HTTPS (enabled by default). This port is also used to check for software updates between the Prime Infrastructure server and cisco.com.</td>
</tr>
<tr>
<td>443</td>
<td>TCP</td>
<td>Prime Infrastructure to Cisco DNA Center server</td>
<td>Device, Groups, Maps, CMX migration to DNA Center.</td>
</tr>
<tr>
<td>514</td>
<td>UDP</td>
<td>Devices to server</td>
<td>Syslog server</td>
</tr>
<tr>
<td>830</td>
<td>TCP</td>
<td>Prime Infrastructure to Device</td>
<td>To open the NETCONF port for communication</td>
</tr>
<tr>
<td>1099</td>
<td>TCP/UDP</td>
<td>AAA server to server</td>
<td>RMI registry</td>
</tr>
<tr>
<td>1522</td>
<td>TCP/UDP</td>
<td>Primary to secondary server, Secondary to primary server</td>
<td>To configure high availability database connection between the primary and secondary Prime Infrastructure</td>
</tr>
<tr>
<td>Port</td>
<td>Protocol</td>
<td>Direction</td>
<td>Usage</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1645</td>
<td>UDP</td>
<td>Server to RAS</td>
<td>Authenticate Prime Infrastructure users via RADIUS Remote Access Server</td>
</tr>
<tr>
<td>1646</td>
<td></td>
<td>RAS to server</td>
<td></td>
</tr>
<tr>
<td>1812</td>
<td></td>
<td>Server to RAS</td>
<td></td>
</tr>
<tr>
<td>1813</td>
<td></td>
<td>RAS to server</td>
<td></td>
</tr>
<tr>
<td>4444</td>
<td>TCP</td>
<td>AAA server to server</td>
<td>RMI server</td>
</tr>
<tr>
<td>8078</td>
<td>TCP</td>
<td>Client to Server</td>
<td>Browser access to Prime Infrastructure via HTTPS to the Cisco DNA Center Coexistence Tool</td>
</tr>
<tr>
<td>8080</td>
<td>TCP</td>
<td>Devices (Cisco Wireless Controllers version 8.6 or higher) to Server</td>
<td>SSL (HTTPS) port for receiving Wireless Client Health Metrics from WLC devices</td>
</tr>
<tr>
<td>8082</td>
<td>TCP</td>
<td>Client to server</td>
<td>Health Monitor web interface, Apache/Tomcat JSP engine</td>
</tr>
<tr>
<td>8085</td>
<td>TCP</td>
<td>Client to server</td>
<td>Used by the Health Monitor process to check network bandwidth speed between Primary and Secondary servers, when the user executes readiness test under High Availability</td>
</tr>
<tr>
<td>8087</td>
<td>TCP</td>
<td>Client to server</td>
<td>Secondary server software update page</td>
</tr>
<tr>
<td>9991</td>
<td>UDP</td>
<td>Devices to server</td>
<td>NetFlow data receiver</td>
</tr>
<tr>
<td>9992</td>
<td>TCP</td>
<td>Lync server to Prime Infrastructure server</td>
<td>Lync data receiver</td>
</tr>
<tr>
<td>10022 to 10041</td>
<td>TCP</td>
<td>Devices to server</td>
<td>Range of ports used for passive FTP file transfers (controller backups, device configurations, report retrieval, and so on)</td>
</tr>
<tr>
<td>11011</td>
<td>TCP</td>
<td>Endpoints to server</td>
<td>Plain text dispatcher port for the Plug and Play Gateway</td>
</tr>
<tr>
<td>11012</td>
<td></td>
<td></td>
<td>SSL dispatcher port for the Plug and Play Gateway</td>
</tr>
<tr>
<td>11013</td>
<td></td>
<td></td>
<td>Plain text plug and play port</td>
</tr>
<tr>
<td>11014</td>
<td></td>
<td></td>
<td>SSL port for the Plug and Play Gateway</td>
</tr>
<tr>
<td>20828</td>
<td>TCP</td>
<td>Devices to Coral</td>
<td>Coral accepts TDL based telemetry including AP and client data from devices. (Specific to 16.10 and 16.11 Cisco Catalyst 9800 Wireless Controllers.)</td>
</tr>
</tbody>
</table>
Coral accepts TDL based telemetry including AP and client data from devices. (Specific to 16.12 Cisco Catalyst 9800 Wireless Controllers.)

<table>
<thead>
<tr>
<th>Port</th>
<th>Protocol</th>
<th>Direction</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>20830</td>
<td>TCP</td>
<td>Devices to Coral</td>
<td>Coral accepts TDL based telemetry including AP and client data from devices. (Specific to 16.12 Cisco Catalyst 9800 Wireless Controllers.)</td>
</tr>
<tr>
<td>61617</td>
<td>TCP</td>
<td>Server to endpoints</td>
<td>SSL port for Java Message Service connections</td>
</tr>
</tbody>
</table>

6 Used when the Plug and Play Gateway is integrated with the Prime Infrastructure server.

7 Used by the Prime Infrastructure Plug And Play Gateway only.

Remove the Prime Infrastructure Virtual Appliance

Removing Prime Infrastructure using the following method will permanently delete all data on the server, including server settings and local backups. You will be unable to restore your data unless you have a remote backup. For other methods of removal, see How to Remove Prime Infrastructure in the latest Cisco Prime Infrastructure Admin Guide.

Procedure

Step 1 In the VMware vSphere client, right-click the Prime Infrastructure virtual appliance.
Step 2 Power off the virtual appliance.
Step 3 Click Delete from Disk to remove the Prime Infrastructure virtual appliance.

Navigation and Documentation Reference

This section provides information about navigational paths to access Prime Infrastructure features, and the details of the chapters where the features are covered in the latest Cisco Prime Infrastructure User Guide and the Cisco Prime Infrastructure Administrator Guide.

Table 8: Navigation and Documentation Reference

<table>
<thead>
<tr>
<th>Task</th>
<th>Navigation in Cisco Prime Infrastructure</th>
<th>Chapter in Cisco Prime Infrastructure Guides</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding licenses</td>
<td>Administration &gt; Licenses and Software Updates &gt; Licenses</td>
<td>Licenses and Software Updates in the Administrator Guide</td>
</tr>
<tr>
<td>Managing Users</td>
<td>Administration &gt; Users &gt; Users, Roles &amp; AAA</td>
<td>User Permissions and Device Access in the Administrator Guide</td>
</tr>
<tr>
<td>Discovering your network</td>
<td>Inventory &gt; Device Management &gt; Discovery</td>
<td>Add and Organize Devices in the User Guide</td>
</tr>
<tr>
<td>Setting up virtual domains</td>
<td>Administration &gt; Users &gt; Virtual Domains</td>
<td>User Permissions and Device Access in the Administrator Guide</td>
</tr>
<tr>
<td>Using monitoring dashboards</td>
<td>Dashboard &gt; Overview &gt; General</td>
<td>Get Started With Cisco Prime Infrastructure in the User Guide</td>
</tr>
<tr>
<td>Task</td>
<td>Navigation in Cisco Prime Infrastructure</td>
<td>Chapter in Cisco Prime Infrastructure Guides</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Using templates for configuring and monitoring</td>
<td>Configuration &gt; Templates &gt; Features &amp; Technologies or Monitor &gt; Monitoring Tools &gt; Monitoring Policies</td>
<td>Create Templates to Automate Device Configuration Changes in the User Guide</td>
</tr>
<tr>
<td>Viewing alarms</td>
<td>Monitor &gt; Monitoring Tools &gt; Alarms and Events</td>
<td>Monitor Alarms and Events in the User Guide</td>
</tr>
<tr>
<td>Maintaining device configurations</td>
<td>Inventory &gt; Device Management &gt; Configuration Archive</td>
<td>Manage Device Configuration Files in the User Guide</td>
</tr>
<tr>
<td>Reconfiguring devices that will be added to your network in the future</td>
<td>Configuration &gt; Plug and Play &gt; Dashboard</td>
<td>Use Plug and Play to Deploy New Devices in the User Guide</td>
</tr>
</tbody>
</table>

**Related Documentation**

The Cisco Prime Infrastructure Documentation Overview lists all documentation available for Prime Infrastructure:

**Note**

We sometimes update the documentation after original publication. Therefore, you should also review the documentation on Cisco.com for any updates.

**Obtaining Documentation and Submitting a Service Request**

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What's New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What's New in Cisco Product Documentation as an RSS feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service. Cisco currently supports RSS Version 2.0.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.